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1. Introduction

1.1. Congratulations on your new product

You are now ready to work more efficiently and keep the precision at an optimum level. Besides that,

you will be more eco-friendly by doing the same amount of work in less time.

The system is designed to show you the information you need on the screen with the greatest

accuracy.
At the construction site, you are the expert - Makin’ 3D is the best work companion you can get.

We at Team Makin wish you all the best with the use of your new system.

1.2. Maintenance

It is recommended to check the system's accuracy regularly. We recommend that the user frequently

checks the positioning against a known point on every job site.

1.3. Storage

Keep the equipment safe when it's not installed in the machine. Use of a protective case is
recommended if the tablet and antennas are removed from the machine to secure the devices from

external stresses such as knocks and bumps.

1.4. Cleaning

The equipment must be cleaned regularly to ensure full functionality over time.

Cleaning is done by blowing to remove dust, you can also choose to use a damp cloth to wipe the

tablet.

Under no circumstances should the equipment be high-pressure washed - neither inside nor outside

the engine compartment.



2. Responsibility

2.1. Installation

All installation and main calibration of the system must be carried out by Makin approved technical

personnel. Failure caused by unauthorized installation or repair could cause a void of warranty.

It is important to follow the machine manufacturer's instructions for installing the Makin machine

control system to avoid violating any machine supplier's warranty regulations.

The user is responsible for using the product in accordance with the given instructions. The user is
also responsible for ensuring that the reference models used are correct and that the bucket is

properly calibrated and controlled.

Broken cables on the system may cause short circuits, system errors, and defective components.
Ensure that no cables have external damage; damage must be repaired immediately before further

use.

Errors in measurement results may occur if the equipment has been subjected to impact, abuse,
modification, or transport damage. Control of the system after such events is important to ensure

an optimum result.

Warranty: For further details, visit www.Makin3D.com for more information.

2.2. Limitations
The product is intended as a control tool, and any use beyond this is not permitted. The supplier or

manufacturer cannot be held responsible for any use that goes beyond the given limits.

2.3. End-user license agreement

License: The system is preloaded with software, which can also be downloaded with permission
from Makin. The software is protected by copyright and other laws. The use of the software is
governed by the license agreement entered into with the Makin' 3D system when purchasing the

product.


http://www.makin3d.com/

For further legal terms and conditions, including but not limited to the applicable End User License

Agreement between you and Makin, we refer you to visit Makin’s website, www.Makin3D.com.

2.4. Warranty disclaimer
Makin provides this documentation without warranty, term, or condition of any kind, either implied
or expressed, including, but not limited to, the implied warranties, terms, or conditions of

merchantability, satisfactory quality, and fitness for a particular purpose.

Makin, its employees, and agents will not be responsible for any loss, however arising, from the use

of, or reliance on this information.

For further legal terms and conditions, including but not limited to the applicable End User License

Agreement between you and Makin, we refer you to visit Makin’s website, www.Makin3D.com.

2.5. Software update

Software will be automatically and frequently updated, and users will get a notification on the screen.
Software updates require a valid maintenance license. To start downloading an updated software

version, users will be asked to agree before the download starts.


http://www.makin3d.com/
http://www.makin3d.com/

3. Product overview

3.1. Tablet buttons and light indicators (Panasonic FZ-A3)

Panasonic
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1. On/Off button 4. Quick access to tablet's menu

2. Volume up 5. Not in use. The button can be
programmed (more info below).

3. Volume down 6. Not in use. The button can be

programmed (more info below).

Additionally, screenshots can be taken by pressing the ‘On/Off button’ and ‘Volume down’
(simultaneously holding down buttons 1 and 3 for about two seconds). This can be useful in the

unfortunate case where assistance is required. Find the screenshots via the ‘Photos’ app.



3.2. Software

3.2.1. How to turn the system on

1) Turn on your Makin’ 3D system by pressing the on/off button on the tablet. Android will start

up and present the ‘Lock screen’.
2) Swipe upwards with one finger on the touchscreen to access Makin’ 3D.

3) If no project has been previously loaded, you will be prompted to do so. See Chapter 4.1:

Open or create a project.

3.2.2. Elements of the work screen

Makin’ 3D offers a variety of screens to choose from. Below is a description of one that includes

most of the available visual features.
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Top bar with status indicators for
connectivity. It also contains features for
resetting the pan and zoom level as well
as changing between screens.

Indication of the slope in the main
direction of the tool point. The arrow
indicates the vertical distance to the
selected height reference. The arrow will
change color depending on the distance
to the target. Tap the indicator to change
the height tolerances.

Indication of the slope in the cross
direction of the tool point. The arrow
indicates the horizontal distance to the
selected side reference. The arrow will
change color depending on the distance
to the target. Tap the indicator to change
the side distance tolerances.

Info bar for Easting, Northing and Height
coordinates.

Tap any element in the loaded 3D model
to bring up the References dialog.

Tap the tablet (also in the static views) to
change the height of the tablet.

Station: Indicate where on the centerline
you are located. To the right of the
Station, you can see the slope along the
road

CL: Distance to centerline. To the right of
the CL, you can see the slope across the
road.

Height: Name of current Height Reference

Side: Name of the current Side Reference.

Change the height offset according to the
current reference - e.g. the specified plane
or the loaded model file.

Quick keys are shortcuts to features
found in the menu.



3.2.3. Touch gestures

Gesture Action

Use one finger to rotate a 3D View.

Use two fingers to pan a Top View or 3D View.

Spread or pinch two fingers to respectively zoom in or out of a Top View or
3D View.

Tap to select.

Sometimes it is possible to long-press for further options.

T | 7| | A




3.2.4. Symbols in the top bar

Symbol

Function

()

Indicating a connection to the internet. The symbol appears white when a
connection is established and gray if there is no connection.

Indicates the number of visible satellites. hARMS (Horizontal Root Mean
Square) and VRMS (Vertical Root Mean Square) indicate the current GNSS
accuracy. Tapping the icon will bring you to the GNSS status menu.

Indication of synchronization of data between server and machine.

An indication that you have remote support from Makin.

This will usually be in connection with a remote support case where you will
be notified.

Bring your machine back to the center of your screen after zooming and
panning.

Placed in the upper right corner. Tap for a change of screen, depending on
the work you are doing and what you want to have in focus.

Toggles between 2D (top view) and 3D view. This button is always placed on
the work screen that it toggles.

-----

Indicating project offset. The symbol appears when a project offset is applied
to the active project.

The tablet is connected to the cloud.

Synchronize to the cloud.

The tablet is not connected to the cloud.

The tablet is disconnected from the cloud because of a secret project.

This symbol is a sensor status indicator. See the pop-up notification for
more information.




3.2.5. Quick keys on work screen

lllustration Menu ID Function
References | Tap to access the References menu. Another way to access
% this menu is to select an element in the 3D model.
NB!
Long hold to access the Project menu.
Log point Tap to quickly log a point, which will be stored alongside
general as-built data.
NB!
The name of the current object is shown on the icon’s label.
NB!
Long hold to access Objects. You need to select an object
before logging a point.
Log line Start logging a line by adding line log points.

NB!

You can select a line and edit it. Select it as a Point of
Interest, name it, and add a comment to it. You can also edit
the line point’s offset. You need to select an object before
logging a line.

Disable log line

Stops the line logging.

)@

Tablet menu

Tap to access the Tablet menu.

Main menu

Menu from where you can access all features of the
system.




Main menu

< Main menu

“ @ I

Project Display Settings

D&l-’\r

Tablet Status




4. Project

Working according to any kind of design is considered a project, whether it is a simple relative plane

or referencing lines and surfaces in more complex 3D models.

( Main menu

“ @ i

Project Display Settings

0O "W A

Tablet Chat Status

4.1. Open or create a project

To open an existing project:

(1 X
> B 4

Logging GNSS

i

1) In ‘Project’ tap ‘Open project’ to see all the projects stored. This dialog is automatically

opened if no project is loaded.

< Project

Bm Open project
Y Project filter

Af References

@ Geodetic systems

DKTM3, DVR90_2013

? — Extend surface

> Plane




2) Tap on the project you want to open, and the download starts.

< Open project + ‘__’ m X

aAa Construction project

aa New hospital

aA Project E12 west
4aA Project E12 east

aa Railway project

AA Test project

3) If you want to create your own local project, tap the ‘+ icon.

< Open project + ‘__’ E X
aA Construction project
a4 New hospital
aA Project E12 west
A Project E12 east
aA Railway project

aA Test project

4) Tap on the local project icon.




4.1.1. Create a secret project

You can create a secret project that will only be available on your tablet and will not synchronize to
the Makin’ Cloud. Secret projects are useful for construction projects needing confidentiality due to

security, critical infrastructure, or competitive advantages.

1) Go to project > Open project
2) Tap on the ‘+-symbol.

3) Tap on the ‘secret project’ icon.

4) Name the secret project.

The icon in front of the project name indicates that it is a secret project:

< Open project + ‘__’ m X

4aA Construction project
aa New hospital

&% Project A6 north

4aA Project E12 west

aA Railway project

44 Test project




4.1.1.1. Remote control for secret projects

If you need support while working on a secret project, you must grant support access to your tablet
during remote control. The secret project will be disconnected and will not synchronize to the Makin'

Cloud, as indicated by this icon:

o\

The support staff can see that your system is online on the Makin' Cloud, but they will not have
access to any details about the secret project. To get support while working on a secret project, you
need to give access to the support staff. When the support staff initiates remote control, a

notification will pop up on your tablet:

Remote Control Request

Do you want to allow remote control access to your
system?

X v

To allow remote control access, tap on the check mark.



4.2. Transfer files

You can transfer files via USB flash drive to secret projects, local projects and cloud projects. You
can import files to the project and export as-built data from the project. Please note: If you import
files to a local project or a cloud project, those files will be available on Makin’ Cloud. For more

details, see section 4.2.1.7: Imported files on Makin’ Cloud.

1) Tap on the ‘transfer files’ icon.
< Open project + ‘__’ m X
aA Construction project

a4 New hospital

&% Project A6 north

4aA Project E12 west
aA Railway project

aA Test project

2) Choose between import to project or export as-built data from the project. Learn more about

importing and exporting in the sections below.

< Transfer files

B Import to project

B> Export as-built




4.2.1. Import to project
You can import files to the project via a USB flash drive. You cannot import single files but only
folders from the USB flash drive. Please note: If you import a file with the exact same name as an

existing file in the project, the new file will overwrite the existing one.

How to import files to the project:

1) Important: Insert the USB flash drive into the tablet first.

2) Tap on ‘Import to project'.

( Transfer files

B Import to project
B> Export as-built

3) You will now be directed to Android's dialog.

4) The first time you insert the USB flash drive you need to make sure that the USB flash drive

is selected. Tap on the ‘three stripes’ icon in the top left corner.
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FZ-A3

N

M Alarms

@8 com.panasonic...

@8 Download

B8 Notifications

Android

com.panasonic....

Makin

Pictures

bluetooth

DcIM

Movies

Podcasts

com.panasonic....
DiagnosticResu...
Music

Ringtones

SELECT

5) Tap on the name of the USB flash drive to open it.



0843 ) T ™M § -

Open from
©  Recent
¥ Downloads
FZ-A3

29,43 GB free

"l-' Pretec USB drive
337 GB free

6) Tap on the folder you want to import files from.



7) Tap on ‘select’. Please note: All the files in the folder will be imported

single files.

0844 () * ™M R -

Pretec USB drive

B8 Trash-1000

@8 cConstruction

B8 html

B8 Models roads

B8 Pictures

B secret files

Alarms

bpciM

LOSTDIR

Movies

Podcasts

System Volume.

B8 Android
B8 Documents
| Music
B8 Recordings

BB Test

Audiobooks
Download
makin3d_sysro...
Notifications

Ringtones

SELECT

. You cannot import



0844 [ * M R -

=  Makin v

B8 Projects
¢y 60100_1.xml ¢y Clroad.xml ¢ Ditchxml ¢y Linejunction.xml
086Jun 213Kk8 08.31 1,78 K8 17 May 1.78K8 17 May
¢ Lines-Driveway.. ¢y Newyard-ver2 ¢y Pipe lines.xml ¢y Waterxml
78 kB Jun 2,138 08.31 1,78K8 17 May 2,138 08.31
—’ SELECT

8) Import of files are completed. You can view the files under Project > References. The

imported files will be marked with a *.

< + 12 91 X
mm Project A6 north @e t
> 60100_1.xml *
>
> contour lines_15263.dxf *
> contour lines_15264.dxf *
> contour lines_15262.dxf *
v
v

o P4(0)
> P3(0)




4.2.1.1. Imported files on Makin’ Cloud
When you import files to a local or cloud project, they will be available on Makin’ Cloud. However,

these files will be stored in your system'’s project folder, and not as part of a global project within

your organization.

How to find imported files on Makin’ Cloud:

1) Go to Makin’ Cloud > Choose organization > Systems

IMAICHT Organizations

Dashboard

Makin

Users

Licenses

Transfer

Q Search | | All systems & °

Projects

Systems 7onine /22

Overview of all systems

Search systems.

System

i Andi-pc

i Daniel FZ-A3

i HJ Entrepreneur

i Morgan Tablet

i Andreas MakinWin
i Andreas telefon

i Ash-A3

i Ash-PC

iaw2

i Brian_pc

i Daniel PC

X

Filter ¥

No.

000-399

000-021

201-002

000-000

100-8000

000-1234

000-4321

000-093

000-0000

000-022

Owner Renter

Makin

Makin

Makin

Makin

Makin

Makin

Makin

Makin

Makin

Makin

Makin

Suborganizations

Settings

Project

Makin Road

vandvaerk, indmalinger
ENG - road project demo
Morgan Home

SK Hjiem

!HJ Demo

0_SL_test_daniel

2) Select the system that imported the files.

3) Open the project folder under that system.

maAicirn

Dashboard Prajects

Organizations

Makin

Users

Licenses

Transfer

Suborganizations

Version

vTI-25

V2.26.x-b81

V2.26.x-b97

V2.26.x-b97

2.16.0°

v2.24.10

v2.25.3

v2.24.12"
vcloud_v24.1.1-112-gc3efd6
v2.22.3

v2.23.14

[L]

Release group

v dev2.26.x
v dev2.26.x
v dev2.26.x
v testing

v

v

Systems

[ ] View on map I

os

{ x86_64
& ARMB4
& ARMB4
& ARMB4
SR x86_64
& x86_64
& ARMB4
=85 64
{ x86_64
== x86_64

S x86_64

Ordered systems (0)

Add system +

GNSS

11(0.0)
11(0.0)
11(0.0)

33(0.9)

HJ Entrepreneur online

Download folder
files
Name

Config

carrection_profiles.json

global.mdb
global.mdb-lock
makin.log
makin.log.1
makin.log.2

pointcodes.txt

Size

1.6 KiB

260.0 KiB

8.0 KIB

588.1 KiB

1.0 MiB

1.0 MiB

278B

Last modified
2 hours

3 hours

24 days

2 hours

2 hours

2 hours

aday

aday

3 hours

Files

Actions



4) Select the project where the files were imported.

MAICHT o

Dashboard

Files  Hardware A

Dow fol

files / Project:

Name Size Last modified Actions
2780 6 months &
60100 ayear
60400 7 months &
63000 7 months &
63100 7 months =
63600 4 hours &

IST-773 8 months &
EH2021-1 8 months &
220 test 10 months &
22000 T months &
37536 7 months &

5) The imported files will be available in this folder.

4.2.2. Export as-built
The USB export function allows you to export locally logged as-built data directly to a USB stick.

This makes it possible to transfer project data without requiring access to the cloud.
Note: Only the as-built data logged by the current user can be exported.
When performing a USB export, the following files are generated:

e LandXML file: Contains points and lines from the as-built logging.

o ZIP file (attachments): Photo documentation for all images linked to the logged points.



Steps to Export As-Built Data via USB:
1. Insert the USB flash drive into the tablet. Please note that it is very important that this is done

as the first step.
2. Open the menu Open project.
Tab the icon displaying the two arrows (Transfer symbol)

4. Tap on ‘Export as-built'.

< NERSERIES

B Import to project
B> Export as-built

5. You will now be directed to Android's dialog.
6. Make sure that the USB flash drive is selected. If not, tap on the ‘three stripes’ icon in the

top left corner and select the USB flash drive.

0844 ) T ™4 R -

=  Pretec USBdrive

Name A
B8 Trash-1000 | Alarms B8 Android B8 Audiobooks
BB Construction @ ocim B8 Documents B8 Download
8 htm! @8 LOSTDIR B8 Makin B8 makin3d_sysro...
B8 Models roads B8 Movies 8 Music B8 Notifications
B8 Pictures B8 Podcasts B8 Recordings B8 Ringtones
BB secret files B8 system Volume. BB Test



7. Tap on the folder where you want to save the as-built data.
Tap on ‘Select’. This will export the project’s as-built data to the chosen folder. A pop-up
notification will indicate that the export is in progress.

e Please note that in most cases, the process is completed so quickly that this notification

may not appear.

0853 () * M R -

= Makin v

Name A

B8 Projects

¢y asbuilt-lens_t.. ¢y asbuilt-Hj test-.
1,78 kB 17 May 2,13kB 08.53
—> SELECT

9. The project’s as-built data is now saved in the selected folder on the USB flash drive. When

the export is complete, a confirmation pop-up will be displayed on the screen.



4.3. Supported file types
When creating a project, the following file types are supported:
e LandXML Roadrunner format (XML)

e Drawing eXchange Format (DXF)

e Norwegian coordinate and observation format (KOF)

New projects are stored in LandXML format.

4.3.1. Project filter

Note: When Makin’ 3D reaches 170 MB data in size, a warning will pop up, informing you that the project
is large. This can reduce performance. The file size depends on the complexity and the details in the
model.

(@) == X % ﬂ

Simulator

N: 6240866.38 Project size is too big x

E'ﬁ6410865(()).93 Failed to load the following files:
: ' Big file/Sewage project/

E18/13700-1_Surface.xml

Filter

If the project reaches 170 MB data in size, part of the model will be shown on your tablet screen near
the application, while the rest remains hidden. As you move the application around, the visible part

of the model will adjust to stay aligned with where your application is.

You can choose to load a part of the project file under Project > Project filter or click ‘Filter’ in the

notification (see picture above).



() == f‘f

imulator

| —
N: 1124108.42
E: 611027.96
H:99.86

< Project

24

Open project
Project filter
References
gﬁggetic systems

Extend surface

Plane

1) Select the folder you want to activate and load by clicking on the button. When the folder is

activated, the button will turn blue.

N: 1124108.42
E:611027.96
H:99.86 _

< Project filter
[ Driveway

Surfaces

[
® Vegetation
(]

Yard




2) Deselect the folders you do not want to load by clicking on the button in front of the folder’s

name. When deselecting the folder, the button will turn off.

N: 1124108.42
E: 611027.96
H:99.86 _

< Project filter
Driveway
Surfaces
Vegetation

Yard

The activated folders will be loaded and displayed under ‘References' in a petrol blue color, along

with the files from the folders.

N:1124109.89
E:611026.12
H:97.39

< + 12 19X
m Road projectDemo A4 @ « § &
>

> Lines-Driveway4.dxf

> Lines-Driveway-2D.dxf

> Makin Points 01.xml

> Makin Surface 01.xml

> New driveway.xml

> New driveway 02.xml

>

>




You can create folders on Makin' Cloud and then drag your project files into these folders: Makin’

Cloud > Project > Choose your project > New folder.

4.4. References

In the ‘References’ dialog, you can choose which part of the 3D model should be active/inactive and

what should be selected as height references, side references, and alert references.
Height references can be points, lines, and surfaces.

Side- and alert references can be points and lines.

N: 1314172.41
E: 75748.08
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1. Tap one of the symbols to select all

4. Green is used for elements that may
elements in the project

reference the height. Press to select as
reference. Long press will deselect all
other height references selected



2. White means an element is visible and
activated

3. Blue indicates an element used as a
side reference. Press to select as
reference. Long press will deselect all
other side references selected

selecting any element in the 3D model.
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N: 1124138.01
E: 610989.52
H:99.38

[

8.20

8.20 m

" CL-vej(51.67 m) &

Centerline-road

5. Red is an alert reference, which gives a
warning when the tool is too close to the
element. Not applicable for surfaces.

6. Highlight elements with yellow color in
the 3D model

As an alternative to going via the menu, you can also find this feature in the Quick Keys menu or by



4.4.1. Folders

In the reference examples below, we see all the data that has been entered on a road parcel.

) %

N: 1124109.43
E 61101725
H: 97.61
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New yard-ver2.xml
New-lines-yard1-2d.dxf »
Lines-yard-north.dxf

In this example, we have six folders:

e Road Models
e Water & drain
e Electricity

e Construction
e Landscaping

e Sewage

If you enable options (i.e., set visible, side reference, height reference, alert reference) for a folder,
you enable the option for all models in the entire folder. For example, if you have many road models,
you may want to open the folder with the small gray arrow to the left of the folder and only activate

the road models that you need.



N: 1124109.43
E 61101725
H: 97.61
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Line junction
Drainage
Rainwater

Folders are shown in blue text - model files are white. File and folder names are scrollable, indicated
with a tiny yellow arrow to the right of their names. A star following a project name indicates the

project is local.

In the above example, we have opened the folder for road models, which contains several individual
files. You can turn on all elements of a folder or turn on some details by expanding individual folders.
Within the folders, you can select specific data to make visible and choose what to actively work

against.

To get an indication of the different model files, side and/or height must be activated. As with
viewing, you do this by tapping the respective blue and/or green boxes. By enabling visibility, side,

and height in combinations, you can customize what information you want on the screen.



4.4.2. Visible reference

All geometries are visible by default and can be hidden by deselecting the white square next to them,

beneath the eye symbol. Calculations are only performed according to visible layers.

(®) R

N: 1124109.43
E 61101725
H: 97.61

+ 12 W7 X

mm Road project Demo

Line junction
Drainage
Rainwater

For example, if we want to make all roads visible in a group of models, simply check the white box
to the right of its folder. It will make all roads visible on the screen. If we only want to see one road,

just activate the white box to the right of the particular road file.



4.4.3. Side reference

Side references are geometries used for side calculations. When models are activated, they have a
blue color next to them, beneath the symbol with the horizontal arrow in the ‘Reference’ dialog. The
closest geometry, activated for side reference, will automatically be used. Lines and points can be
selected as side references - not surfaces. The calculated side distance is the horizontal distance

to the geometry.

4.4.4. Height reference

Height references are geometries used for height calculations. They are indicated with a light green
color when activated in the ‘References’ dialog, beneath the vertical arrow symbol. The lowest
geometry, with height reference enabled, will automatically be used. Height references are typically

surfaces, but lines and points can also be selected for height calculations.

4.4.5. Alert reference

Alert references are geometries used for alert calculation. The closest geometry activated as an
alert reference with a red square beneath the warning symbol will automatically be used. Lines and
points can be selected as alert references - not surfaces. Unlike the calculation of side reference,

the calculated alert distance is the closest Euclidean distance (shortest path) to the geometry.



4.4.6. As-built data

As-built data is data used for documentation of the performed task. As-built data can be used in
different ways: to document that the project is built the same way as it was originally designed or to

document if extra work has been performed, e.g., how much soil is being removed from an area.

The as-built data is collected when the machine works, and the data is logged by the operator. These
data can be used later in the process to assure the quality of the project and/or to calculate the
volume of material that is added or removed from an area. As-built points will be saved in the

overview if it is necessary to navigate to the points at a later stage of the project.

As-built data can be used as references in a similar way as other references. The green points are
your own points, and the purple points are points from other applications. The lines and points are
continuously saved and synchronized to the Makin’ Cloud, where they can be downloaded as .CSV,
.KOF or XML formats.
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4.4.7. Lock Reference (line, point, or surface)

Makin can work with multiple active references at the same time. This allows the user to activate
and work with the references when moving the tool point over them. The active reference will
automatically switch to the one closest to the tool point. While doing this, and with a lot of references
often close together, it can be difficult to avoid the references from switching if you want to navigate
to a specific height or side reference or to a reference further away than other selected references.
In this case, the user can lock a reference, isolating the navigation to this specific reference without

deactivating all other active references.
You can select and lock a line, point, or surface that will be used as a reference.

If you are moving the tool point around on the project, the height and side reference will keep being

locked to the selected reference, thus keeping this as the reference.

Locking a reference can be done in the reference menu or directly on the work screen:

1) Select an object by pressing the object name or directly on the visualized object on the run

screen.

2) Press the lock icon to lock the selected reference.

0.0%

B leftside

3) Select ‘Side’, ‘Height’ or both:

0.0%

Bl leftside

You can see that both ‘Side’ and ‘Height’ have a lock on them.



Bl leftside

4) If you want to unlock it again, just tap once on the lock, and it will disappear.

5) If you want to lock the reference directly under your tool point, this can be done by pressing
the lock icon next to the reference name on the work screen. This will toggle the lock icon

between open and closed for either height or side reference.

Station: 380.33m -30%o

(g 1.38m 2%
Height: 1.1_Trau_60100 & \
Side: 1.1_Trau_60100 (389.39 m)

0 3




4.4.8. Dynamic 2D files

2D files, also known as background files or display models, are defined as files with no height
information available. The height of all points in the file is set to 0.00 meters. These files are often
used as background to visualize existing infrastructure or drain pipes where height was not logged
originally. When working on projects with the 2D files, they are not placed at a height of 0.00 meters.
They are moved closer to the project, right below the active 3D references' lowest point. These files
are handled dynamically, so whenever a 3D reference is activated or deactivated, the 2D files adjust

accordingly.

L T716
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4.4.9. Copy Point

You can now copy and edit a point by selecting one from the design model. However, it should be

noted that you are not able to modify the points in the design model itself.

By using the edit feature, you can change the point's properties, such as its height. The edited point

will be saved under your own points list (user model).

Additionally, you can utilize the Copy Point feature to duplicate any points from your personal point

list.
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4.4.10. Stakeout

Stakeout is showing the information for the selected line, point, or point on a line. To stake out an
element, press the element in the graphics or press the element name in the reference dialog, and
press the stakeout icon at the top of the reference dialog. A popup will appear with all the stakeout

information for the selected element. The stakeout menu can be freely moved around on the tablet.
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Stakeout

Measurement

[Delta Station
=16.85 / 34.57

Measurement: Shows measurements between the tool point and the selected reference for the

stakeout.
Reference: Shows information about the entire selected reference for stakeout.

Segment: Shows information about the active line segment (gray line). Only shown for lines that

contain segments.

1. Horizontal distance between tool 8. Horizontal length of stakeout line.
point and selected reference.
Measured perpendicular to the line.

2. Vertical distance between tool 9. Length of stakeout line.
point and selected reference.

3. Inclination between selected 10. Segment type can be line, arc, or clothoid (spiral,
reference and tool point. transition curve).



Stationing of the selected line. 11. Horizontal length of line segment.

Horizontal distances from present ~ 12. Length of line segment.
stationing to the end points of the

active line segment (colored gray).

The line will be extrapolated, if the

tool point is in front or behind end

points. In this case, the value will be

negative to the closest end point.

Name of selected stakeout line. 13. Height difference of the line segment.

Type of selected reference (arc, 14. Slope of the line segment.
circle, line, polyline, road line)



4.4.10.1. Stakeout to a point

When you want to stake out to a point, you can press the point or click on the name of the point in
the reference dialog, and then press the stakeout icon AE

A bullseye and a popup with the stakeout information will appear on the screen. The blue line in the

bullseye indicates the long slope direction, and the red line indicates the cross slope direction.

The popup with the stakeout information will show information about measurement and reference.

Name: P56

/ Measurement
Horz Dist 5.97 m
Vert Dist 1.00 m
Incline 9.5°

<@+ 124ir®
mm Road project Demo A
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O
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Reference

Name: P56

Type: Point
Category: Logpoint
N: 1124343.34

E: 610971.24
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8 P56 (0)
> P73(3)
> P55 (0)
. P72 (3)
P54 (0)
P53 (0)
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4.4.10.2. Stakeout to a line

When you want to stake out to a line, you can press the line on the screen or click on the name of
the line in the reference dialog, and then press the stakeout icon AE

A dotted line from the application to the selected line will show on the screen, along with a popup
with stakeout information. The stakeout information will show information about measurement,

reference, and segment.

If you move beyond the line, the dotted line will show the extrapolation of the selected line. Please

note that if you stake out to a side reference, the line does not extrapolate.

Name: PolyLine1
Measurement
Horz Dist 3.71 m
Vert Dist 0.84 m
Incline 12.8°
Station 322.28 m
Delta station
9.61/0.47

o
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> PolyLine3 [ |

-/ > PolyLine4 [ ]
> Points .
> Vej.xml [ ]
> Vej2.xml

> Vej2A.xml




4.4.10.3. Stakeout to a line point

If you want to stake out to a point on a line, you must press the arrow between the line symbol A

and the name of the line in the reference dialog. Then the name of the line point will appear

underneath the arrow. Select the line point you want to stakeout to, and then press the stakeout icon

Al

N: 1124337.39

< + LU XL + 2 4@ v[1 X
mm Road projectDemo A @ < § mm Road projectDemo A @ < §
vV Lines [ ] V Lines [ ]
PolyLine1 [} / W PolyLine1 [ ]
PolyLine2 [} P1 (PolyLine1

)
PolyLine3 [} P2 (PolyLine1)
PolyLine4 [} o P3 (PolyLine1)
Points [ ] o P4 (PolyLine1)
Vej.xml [ | o P5 (PolyLine1)
Vej2.xml o P6 (PolyLine1)
Vej2A.xml P7 (PolyLine1)

A bullseye and a popup with stakeout information will appear on the screen. Like stakeout to a point,
the blue line in the bullseye indicates the long slope direction, and the red line indicates the cross

slope direction.

The popup with stakeout information contains information about measurements and references.



4.4.10.4. Stakeout to side reference

You can stake out to side references, which allows you to see multiple elements’ information by

jumping between them when you use the stakeout feature.

How to use:

1) Activate the elements you want to use as a side reference by pressing the boxes underneath

2)
3)

the blue horizontal arrow in the reference dialog. When you activate a box with a blue edge it

will change to a fully blue box.

Press the stakeout icon A E

The application will now stake out to the nearest element, and when you move around, the
application will switch to stake out to a new nearest element. A popup with stakeout

information will also appear on the screen.

The popup with stakeout information will show information about the name of the element,

so you know which element the application stakes out to. The popup also contains

information about measurements and references.

P77 (0)
o P76 (0)
o P95 (3)
o P94 (3)
o P75 (0)
o P93 (3)
o P74 (0)
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P73 (0)
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E: 610971.86
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Name: P56
Measurement
Horz Dist 0.69 m
Vert Dist 1.00 m

Incline 55.3°

Reference

Name: P56

Type: Point
Category: Logpoint
N: 1124343.34
E:610971.24

H: 98.76




4.4.11. Create point from coordinate

1) Press on References:

é Main menu | Project

A4 Open project
Al References

2) Pressthe ‘+:

< + 12 @7 X
Bm ENG - road projectder @ « §
>

>

> CL-road.xml B

> Ditch.xml [ |

>
> Lines-Driveway4.xml [ ]
> Lines-driveway-2D.dxf [ ]
> Lines-driveway.dxf [ |
v Lines-driveway4.dxf [ ]

3) Press the pointicon:

< o I3
mm ENG - road proje jle

P

@

CL-road.xml V
Ditch.xml

Lines-Driveway4.xml
Lines-driveway-2D.dxf
Lines-driveway.dxf

Vv Lines-driveway4.dxf

The point will have the coordinates of the tablet’s selected measurement point.



Create point D E

Name P4
Northing 1124153.01 m
Easting 610951.79 m
Height 101.78 m

v

4) Set a name for the point.

5) The point’s coordinates can be adjusted manually.

6) Itis also possible to adjust the tablet’s position and fetch the new position of the tablet (see

the tablet icon in the picture above).

7) Tap the check mark to confirm the new point.

Points you have created yourself can be found at the bottom of the References under User model >

Points.



4.4.12. Create line from points

1) From ‘References’ tap ‘+' and then ‘Line’.

You can create lines between existing points - either from a design model or from points you have

created yourself.

The line will be created in the order in which points are selected, and you will see how the line appears

in the on-screen overview.

2) You will be prompted to ‘Select the points for the line'.

3) Select the points individually by either picking points in the 3D visualization or highlighting

the yellow icon next to them in the list.
4) Finish by pressing ‘OK'.
5) Give the new line a name.

6) If you have selected three points or more, you can select the ‘Close line segment’ option to

connect a line between the first and last points.

7) Finish the line by pressing ‘OK'.



4.4.13. Create profile along lines

1) From ‘References’ tap ‘+' and then ‘Profile’ . .

The line will function as the centerline for the profile, where you can add any number of surfaces on

either side of the line.

2) You will be prompted to “Select the lines for the profile”.

3) Select the lines for the profile in the 3D visualization or in the list. When done, tap ‘OK'.

4) Give the profile a name.

5) Press the '+ button on the left and right side of the screen to respectively add new surfaces

on the left or right side of the line.

6) Adjust each of the surfaces’ width, Deltaheight dH, and angle according to the design that

you want.

7) You can also adjust the height offset of the entire profile.

4.4.13.1. Edit profile

You have the possibility of editing an existing profile. In this way, you can edit the profile’s width and

slope of the surfaces, as well as add or remove surfaces.

1) Under User model; longhold on the profile surface name, which you want to edit.

2) Click on the pen tool, which will appear.
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3) Adjust the width, the deltaheight dH, and/or the angle of the surfaces by clicking on the

numbers you want to change.
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4) The profile will now change according to the new width and slope of the surfaces.

4.4.14. Edit Line
You can edit line points in the user model if you need to change the coordinates/location of an
existing line. Be aware that you can only edit your own lines located under the user model, meaning

that you cannot edit lines from project- or As-built data.

1) Go to References > User model > Lines.
2) Click on ‘Lines’.

3) Choose the line you want to edit by clicking on the line or the arrow in front of the name of

the line. For example:

¥ v

4) Click on the point of the line you would like to change, for example:
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5) Click on the pen tool to edit the line point.
6) Change the desired coordinates of the point’s position. The line will now change in relation

to the point’s new position.

R2A(Reit edge)

£ Edit P2 (Left edge)
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4.4.14.1. Copy a line from design data in order to edit it
Because you cannot edit lines from design data, you can instead copy a line from the design and
edit the copied line points in the User model. In this way, you can still follow the line and make

adjustments to the line points, e.g., if you want to change the height of a line point.

How to copy a line:

1) Select the line you want to copy from the design.

2) Click on the ‘Copy’ icon:

-

3) You can rename the copied line. Press ‘Ok’ to copy the line.

4) The copy is now under ‘User model’, where you can edit the line.



4.5. Infield Design

To open the Infield Design function, go to the Reference menu.

1. Click the +icon on the menu bar in top of the Reference menu.

2. This will open a drop-down menu. Select the Infield Design icon.

3. Wait for the Infield Design section to open.



4.5.1. Points and lines in Infield Design
The Infield Design is equipped with an Add point- and an Add line-button.

©

Add point
+7

I’.

Add line

—
-

Add surface

é

ExitiInfie|d
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Use these to add the needed data or work from already logged data. The workflow when logging

points and creating lines in Infield Design is almost the same as when logging regular as-built data.

1. Click the icon for the data you need to log.
2. Place the tool point in the correct position.

3. Click the Add point from TP-button on the screen. This will log a point.

®

Add points ?(
ofmt

Add points from tool by pressing the add p
| button.

4. Move the tool point to the next position.

5. Repeat until all desired points are placed and click the OK button.

Please note: If you close the pop-up window by pressing the X, all data created before pressing OK

will be deleted, and it is not possible to recover it.



4.5.2. Info box for line

When a line is created, you can access its relevant information. Simply select the line and click the

Info-button on the left-hand side of the screen. This will open a pop-up window.

o X

Simulator

o Info
2D length: 24.35 m
Info 3D length: 24.57 m

4.5.3. Create a boundary

1. When the points are logged, click the Add surface-button.
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Simulator
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Add surface

Exit Infield




2. Click the Boundary-button.

ol

Simulatar

Create surface x
Boundary Select points for the surface, or add points ffom

@ tool by pressing the add point button.

—

Add point from TP O k
—_— —

3. Select the points there are a part of the boundary and click OK.

o

Simulator

I !
® Create Boundary x
int

Add point from TP Select points for the boundary line, or add p
from tool by pressing the add point button.

® P4(0)

4. Aboundary has been created.



4.5.4. Calculate volume
1. Start by creating a surface based on your boundary.
2. Click the Add surface-button.
3. Click the Boundary-button and select the created boundary. When selected press OK.

® Create Boundary x
nt

Add point from TP Select points for the boundary line, or add p
from tool by pressing the add point button.

4. Select the top points to create the surface. When the points are selected, click OK to create

the surface.

& # ®

Simulator

a Create surface x
om

Boundary Select points for the surface, or add points
@ tool by pressing the add point button.

Add point fremses




5. Select the surface and click the Volume to boundary-button to calculate the volume.

& ¥

Simulator

IJ'\\

Volume/ta floor

A

Volume to boundary
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6. This will open a pop-up window showing the volume.

Volume X
Volume to floor Volume: 96.69 m?

A

Volume to boundary

©

Make Report

7. If more information is needed, click the Info-button to open the info box.

& ¥ @

" Info

- 2D Area: 79.83 m?
3D Area: 106.93 m?
2D Circumference: 37.34

Volume/ta filoor

m
Volungeltolbatintalm] 3D Circumference: 37.34
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4.5.5. Infield Design report

It is possible to create an Infield Design report with all the relevant measurements. Create the
report by clicking the Make report-button, this will export the data to Makin’ Cloud. Please note that
the report can only be generated once the volume has been calculated and Infield Design has
collected all the relevant data.

®

Volume x
Volume to floor Volume: 96.69 m?

A Make Report

Volume to boundary

@ ."-»

Go to the cloud and open the PDF. Please note that the image in the report is a screenshot taken at
the moment when ‘Make Report’ is clicked. It is therefore important to be aware that the screen
displays the measured area if you want to have the correct area shown in the report.



4.5.6. Exiting Infield Design

To exit the Infield Design click the Exit Infield -button or the Infield Design icon at the bottom of the
screen.
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4.6. Geodetic systems

Only in rare cases should the machine operator be concerned about selecting the correct coordinate
system and geodetic model. With Makin’ 3D these matters are handled in a central place - e.g., the
construction office. When made available, the geodetic system cannot be changed on the excavator.
It is possible though, to handle the geodetic system locally when required by simply not having it

preselected for a particular project.

4.7. Extend surface

Extending the surface allows you to continue your excavation even if you are beyond the design that
is already at hand. By selecting ‘Extend surface’, you extend the road surface you are working on -
even if the actual design has limitations. The same is true for cuts where the cutting surface is too

short for you to find the cutting top.

() #

N:1124141.79

E: 610980.73 Open project

H:102.29

Project filter

References

Geodetic systems D

DKTMS3, DVR90_2013

Extend surface [
Plane >
Temporary profile

Proiect nffaet N NN m

The way the surface extends depends on the file format you are using:

Road formats: For road formats like road lines and xml. files, the surface will extend perpendicular

to the centerline when you select ‘Extend surface’.



Other formats: For surfaces with other formats like dxf. and landxml. the surfaces will extend with
a heading cut across, when using the feature ‘Extend surface’. It means that the extended line will

move along with the bucket’s cutting edge.

Note that when you extend the surface, only the current tool point’s height will be shown when you are

beyond the design. Only one height will be calculated, which will be the height from the active tool point.

Extend surface using road formats:

© %

N: 1124140.31
E: 610986.17
H: 102.04

Extend surface using other formats:

) #

N: 6240807.46
E: 461800.22
H: 55.50




4.8. Plane

By activating the ‘Plane’ feature, you get a virtual reference plane, which can be either flat or sloping
with a 1-sided or 2-sided fall.

@ #

Simulator

N: 6751664.86
E: 604280.17
H: 143.61

Station: -

ClLs -
Height: Plane &

Use ‘Main direction’ and ‘Main slope’ to indicate the plane’s longitudinal direction and angle.

Likewise, set the transverse slope of the plane with ‘Side slope’.

With the ‘Elevation’ option, specify the absolute elevation height or quickly get the current height of
the tool point. Another option, called ‘Set plane here’, also uses the current tool point height, but with

the addition of taking the reference height offset into account.

When the plane is active, you can tap the visual part of the plane to quickly change its values. When
you no longer need this feature, it is important to disable the plane. If you do not do this, the activated

plane will follow the machine wherever it may be located.

Tap to activate and deactivate a virtual plane and change the longitudinal direction, longitudinal

slope, and transverse slope.

If you set the height manually and then enter a longitudinal fall, the point for starting the slope will
still be below the "cross thread", which forms the center of the measuring point on the bucket. Those
are the E and N coordinates that you can see in the upper left corner. It is important to keep in mind

that the measuring point on the bucket is above the desired starting point for length/cross slope.



4.9. Temporary profile

Toggling the ‘Profile’ option turns the temporary profile on or off while its settings are retained.

There are two options for moving the profile, respectively ‘Set profile here’ and ‘Set profile &
direction here’. The first option horizontally displaces the profile and positions the middle of its
centerline at the tool point. In addition, the latter option also rotates the profile according to the

heading of the bucket/attachment.
Adjusting the ‘Slope’ will tilt the profile along its baseline.

Under ‘Edit profile’ you can change the profile’s contours by adding and removing surfaces as well
as changing the width and slope of the surfaces. Changing slopes can be done either by specifying
the height difference between two surfaces or by specifying the percentage slope between them.
Also, you can specify a height offset for the profile, where the baseline is indicated by a gray line in

the 3D view.

(@) x

Simulator

N: 1124655.07
E: 611020.40
H: 107.23

Station: 0.95m

@Ls 7.65m

Height: -

Side: CL-vej_02 (0.95 m) ém

Edit profile x

Profilename P

LU

Width [m]‘ i .‘v-[ 1 _

dH [m] ‘

angel%ll 0.0 [0.0[0.0{0.0]0.0

Profile offset

The profile can be rotated by using ‘Edit direction’. North corresponding to 0 (zero) degrees. The

feature ‘Get direction from tool’ will align the profile according to the bucket/attachment.



As an alternative to going via the menu, you can jump to this feature by tapping the profile in the 3D

view.

4.10. Project offset

Project offset is designed to adjust a machine's height to match the height of the design project you
are working on. Even if a machine is correctly calibrated, the height measured by the tool point in
the application can differ from the height of a known point on the project. These differences can
occur as a result of differing reference systems, e.g.: localized coordinate projections vs. official
coordinate projections. Other sources include small variations between GNSS manufacturers as well

as incorrect heights used in the initial project design.

To mitigate this, we have added the project offset functionality, which adjusts the received GNSS

height (not the antenna height) to match the height of the known point on the project.

Note:

You must ensure that the machine is calibrated correctly before adjusting the project offset.

Project offset is limited to adjustments of +/- 50 cm.

Project offset can be adjusted in: Main Menu > Project > Project offset

< Project

Geodetic systems

NTM zone 11, NN2000

Extend surface

Plane

Temporary profile

Project offset

Change offset




How to use:
1) Inside the project offset menu, you will see the tool point height of your application in the

value area.

Project offset

2) Enter the correct height of the known point in the value area to calculate a project offset.

3) Itis also possible to adjust the project offset using the +/- buttons, increasing or decreasing

the value by 1 cm per tap.

4) A project offset is calculated and visible in the project menu. When you have a project offset,

the icon will be visible on the work screen.

-----

To remove the project offset, go into the Project Offset menu and tap the trash can icon.



4.11. Change offset

E: 75738.01

Station: 56195 my/

Entering this menu adjusts the height offset you want to have for the whole project. Typical uses are
where you have only been given the surface of a road and should dig for a ditch or other layers
beneath the surface. If the ditch is known to be 0.85 meters under the finished road, then adjust the
offset value t0 -0.85. A parallel surface/line will then be created 0.85 meters beneath the theoretical

model. The whole model will be offset.

You can enter the desired value manually or move your finger up or down in the vertical field.



Change offset

0 (.
X @® Show original model v

If you have applied an offset but want to view the model with its original offset, enable 'Show Original
Model'.

Change offset

0 .
X @® Show original model v




5. Display

< Main menu

A @ I

Project Display Settings

0O " A

Tablet Chat Status

Q)

Logging

i

Manual

41X

&‘f

GNSS




5.1. Labels

A label is the name of a geometry object of the following type:

e Points

e Lines

e Surfaces

e Stations

e Log Points

e Log point codes

e Texts

It is possible to choose which type of label should be visible by selecting/deselecting it on the list.

N: 1124658.73 =S N: 1124658.73
E: 611047.77 E: 611047.77
H: 97.68 H: 97.68

é Main menu | Display é Main menu | Display | Labels

Labels Points

Dark theme Lines
Show maps Surfaces
Transparent surfaces Stations
Select screen sidebar Log points

<& Show textures Log point codes




5.2. Screen indicators
It is possible to hide some of the screen indicators in the work screen area. This function is

designed to let you remove non-essential features, that could be distracting on the screen.

With all screen indicators:

r— @ @' ﬁl < Screen indicators
H: 228.82 . . Cloud status

GNSS status
Station
Centerline

Height
Station: 16.82m

CL: 5.0 cm Side
Height:

Side:

i O
b CI 456456&5 - Pipe

With selected screen indicators:

L= O || & screen indicators
Cloud status
GNSS status
Station
Centerline
Height

Station: 16.82m

Height: - S|de

i O
b II 456456&5 - Pipe




5.3. Use file color

This feature changes between using the colors stored on file or the default color scheme of Makin’
3D. In some situations, it gives a better overview using the colors of the model file and will make it

easier to separate elements in a complex file.
If file color is not enabled, Makin’ 3D will use default colors.

Be aware that some files can include black-colored lines or designs, and these will not be visible if

file color is selected.

e Tap to select/deselect file colors.

é Main menu | Display

Auto hide RMS

Reverse quick keys
& Show other systems
a4  Use file color

@ Wireframe

View settings




5.4. Show maps

The user can hide or show maps along with the project to get a better overview. The map will be

shown below the lowest active 3D reference in the project.

The tool cuts are shown on the map in Top View. Otherwise, tool cuts are only shown on elements

of the 3D model marked as a height reference.

Note: In the 3D View, the map will be seen in a perspective view. If you want to see it straight from

above, use the Top View instead.

e Tap to select/deselect visibility of map.

(@ ¥

@ #

N: 1124665.34
E: 611041.72
H:100.25

N: 1124665.34
E:611041.72
H:100.25

Station:  0.00 m

CLs 30.00 m
Height: -

Side: -3(0.00 m) &

Station:  0.00m

CL: 30.00 m
Height: -

Side: -3(0.00m) @

é Main menu | Display

Labels

é Main menu | Display

Labels

Dark theme Dark theme

Show maps 2 Show maps
Transparent surfaces Transparent surfaces

Select screen sidebar Select screen sidebar

<& Show textures <& Show textures




5.5. Show other systems

N: 6240851.93
E: 461840.48
H:59.70

Station: -
CL: >
Height: -
Side: P135(3)(9.42 m) &m

é Main menu | Display

Auto hide RMS

Reverse quick keys
0da  Show other systems

4A  Use file color

@ Wireframe

View settings

Other systems currently working on the same project—like machines, rovers, etc.—will show up.

N: 6240851.93
E: 461840.48
H:59.70

Station: -

QL

Height: -

Side: P135(3)(9.42m) &m

é Main menu | Display

Auto hide RMS
Reverse quick keys
0d. Show other systems

4A  Use file color

@ Wireframe

View settings




5.6. Show textures

Instead of using solid colors, you can have textures shown. This is only possible with road geometry.

N:1124659.54 N: 1124659.54 g N: 6240861.77
E:611016.67 E:611016.67 E: 461836.49
H:98.92 g H:98.92 H:54.43

O

2.01

Station: 0.00 m < Station: 0.00 m
cL: 4.56m CL: 4.56 m
Height: - Height: -

Side: - Side:

é Main menu | Display é Main menu | Display

Labels Labels

Dark theme Dark theme

A\ Show maps Show maps

Transparent surfaces Transparent surfaces St 7220
CL: 2.01m
Height: -

Select screen sidebar ] Select screen sidebar J e

Y& Show textures Y& Show textures




5.7. Tool point coordinates

You have the option to show or hide the tool point coordinates in the app. When activated, the

coordinates for north and east will be displayed along with the height. If deactivated, only the height

will be shown.

< Display

Labels

Dark theme
A Show maps
Transparent surfaces
& Show textures

Tool point coordinates

< Display

Labels

Dark theme
A Show maps
Transparent surfaces
& Show textures

Tool point coordinates




5.8. Machine speed

This feature ‘Machine speed’ shows the speed of the machine, working like a speedometer. The
speed is displayed in kilometers per hour (km/h). When activated, the speed will appear in the top
left corner.

<
H: 103.60 H: 103.60

< Display ‘ < Display

Dark theme Dark theme

S\ Show maps A\ Show maps
Transparent surfaces Transparent surfaces
& Show textures % Show textures
Tool point coordinates Tool point coordinates

Machine speed Machine speed

5.9. Auto hide quick keys

Auto Hide Quick Keys will hide the “quick keys” at the bottom of the screen after about 8 seconds of

not touching the display.

When you touch the display, they become visible again. It will give you a clearer view of what you are

working on when icons are hidden.



5.10. Reverse quick keys

This feature places the quick keys to the right of the menu button. It makes it more convenient to
log points from the right-hand side of the screen without having to visually locate the point logging

feature.

é Main menu | Display

Select screen sidebar

Y& Show textures
Auto hide quick keys
Auto hide RMS

Station:  74.96 m
Cls 21.36 m

Reverse quick keys Height: -

Side: centerlinie (74.96 m) &

Station:  74.96 m

@ls 21.36 m
Height: -
Side: centerlinie (74 96 m) &=

VN

Show other systems




5.11. Transparent surfaces
Hide the surfaces to be able to see lines and points beneath them.
Note: Surfaces with textures will not be transparent.

Warning: Reference selection is not visible when transparent surfaces are enabled.

N: 6240877.81
E: 461853.02
H: 44.88




5.12. Dark theme

By default, the machine control system has the ‘Dark theme’ enabled, which is great at night time or
when working in dimmed conditions. It is recommended to disable this feature when working in a
bright environment, especially while working in direct sunlight, when staking out points outside the

cabin, etc.

(@) ﬁ?

E:75793.95 E; 75793.95
N: 1314228.06 | N: 1314228.06
H:232.99 | H: 232.99

= 35.10 m -2.5%
| b CLs 0.51 m -3.0%
Height: 1.01_111_Trau Helght: 1.01_111_Trau
Side:  centre_111_Trau Side: centre_191_Trau

é Main menu | Display

Auto hide quick keys

é Main menu | Display

Auto hide quick keys

Reverse quick keys Reverse quick keys

Transparent surfaces

Transparent surfaces

Dark theme

@ Wireframe

Change screen

Charn

Dark theme

@ Wireframe

Change screen
o g screen




5.13. Wireframe

Tap Wireframe to enable the triangular design to be visible. This will show the edges of the triangles

and might improve their visibility.

@ ¥

N: 1124152.96
E: 610958.50

. (\

Station: 504.37 m
Gl 3.47m
Height: -

Side:

é Main menu | Display

Auto hide RMS

Reverse quick keys
0da  Show other systems

44 Use file color

@ Wireframe

View settings

5.14. View settings

To obtain a better overview of your work, you now have the option of hiding the excavator or making

it transparent.

Open the menu and select Display. Scroll down to View settings.

It is possible to set this individually for a work situation or when you touch the screen. You can also

choose individual settings for runscreens with 3D View or Top View.

You can now easily toggle between 3D View and Top View by pressing the icon in the upper right

corner.



Menu > Display > View settings > Top view

@ ¥

N:1124152.96
0958.07

Station: 504.37 m
CL: 3.28m
Height:

Side:

é Main menu | Display | View settings | Top view
When working

When touching screen

Menu > Display > View settings > 3D view

(@) X

N:1124152.96
E: 610958.07
H:90.12

é Main menu | Display | View settings | 3D view

When working

When touching screen

Visible
Visible

Visible
Visible

1124152.96
610958.07

124152.96
10958.07

Station: 504.37 m Station: 504.37 m
CL: 3.28m
Height:

Side:

é Main menu | Display | View settings | Top view x

Shadow

é Main menu | Display | View settings | Top view x

When working When working Hidden

When touching screen Shadow When touching screen  Hidden

© *

© .

N: 1124152.96
E:610958.07
H:90.12

N:1124152.96
E: 610958.07
H:90.12

é Main menu | Display | View settings | 3D view

é Main menu | Display | View settings | 3D view

When working Shadow When working Hidden

When touching screen Shadow When touching screen  Hidden




5.15. Change screen

This option is to change the working screen. Tap the icon in the top right corner and select the

workscreen option you want to display.

Stadon:  105.1C4ul Stadon:  105.1C4ul




6. Settings

(Mainmenu Ex
“w @ it 9O ~

Project Display Settings Logging GNSS

0O "™ A M

Tablet Status Manual

6.1. Tolerances

Tolerances are thresholds for calculations. They are used for different indications, like colors and

sounds. You can change the tolerances for height, side, and alert.

When working outside the specified tolerances, the indicator in question is shown in white color.



6.1.1. Height tolerances

1) Tap ‘Height'.

< Settings

Height

Side distance

Alert

Measure time

Language English

Length unit Meters

2) Tap ‘Heigh tolerance’.

< Height

% Snap to surface

=| Height tolerance

3) Choose any of the 3 options (Red, Yellow, Green).

( Height tolerance
| Yellow

Green above

G en below

Red |
) Sound




4) Enter the tolerance.

The ‘Yellow’ band for the height tolerance indicates a distance for when to start showing that you

are near a selected height reference.

‘Green above’ and ‘Green below’ are the limits for the accepted height deviation, respectively above
and below the reference. As long as your measurements fall within these green zones, the deviation

is within the allowed range, and the job meets the required standards.

‘Red’ is an indication of excavating too deeply into the ground. The tolerance is an expression for

when to ignore the warning when you are far below the reference.

The sound option will enable different sounds depending on the band within which you are working.

There will be no sounds when working above the yellow band and below the red band.



6.1.1.1. Snap to surface

If you have multiple height references activated, you can select whether the tool point should snap
to the lowest or the highest surface. This means that when height references for multiple layers are
active, the tool point will automatically snap to either the lowest or the highest surface, depending

on your chosen setting.

1) Go to Settings > Height.

2) Tap on ‘Snap to surface’.

< Height

% Snap to surface

Height tolerance

3) Choose between ‘Lower’ and ‘Upper’ to snap to the lowest or highest surface depending on

your preference.

< Snap to surface

Upper

Lower

4) Thetool point will now snap to the lowest or upper surface depending on your chosen setting.



Station: 197.48 m
CL: 3.0cm
Height: 2A @
Side:

6.1.2. Side tolerances

For the side distance, ‘Red’ means that you are approximately within reach of your target, and ‘Yellow’

means that you are even closer. The ‘Green’ band indicates the accepted deviation from the target.

Keep in mind that the side distance is calculated horizontally and is not the shortest path.

1)
< settings
Height
Side distance
Alert
Measure time

Language English

Length unit Meters




2)

< Side distance

mm Side tolerance

3) Choose any of the 3 options (Red, Yellow, Green).

( Side tolerance

fee
e

Green

4) Set the tolerance.

Yellow




6.1.3. Alert tolerances
The tolerance for alert is divided into Show, Warning, and Danger.
e If you are in the ‘Show area’, a red 3D line will be shown.
e If you arein the ‘Warning area’ you will get a warning notification saying, “Too close”.
e If you are in the ‘Danger area’ you will get a danger notification, and an alarm will sound if

turned on.

1)
< Settings
$ Height

<«» Side distance

A Alert

0D Measure time
B3 Language English

™ Length unit Meters

2)

< Alert

m Alert tolerance

3) Choose any of the 3 options (Show, Warning, Danger)



Show

Warning
Danger

) Sound

4) Change the distance you want from the point of alert.

Warning

You will have a sound option as well. Activate the button for sound or deactivate it for mute sound.



6.2. Measure time

For the most accurate measurement in the Makin’ 3D app, you can adjust the measured time
settings. You can also improve accuracy by allowing the sensors to stabilize and reducing

surrounding noise from GNSS by delaying the measure time.

< Settings

() Leveling meter
$ Height

<+> Side distance
A Alert

0D Measure time

B3 Language English

In the 'Measure time' menu, you will see two functions: Measurement time and Delay time. These
settings allow you to fine-tune the measurement process for the most precise results. Learn more

about how to use these settings in the following paragraphs.

< Measure time

{» Measurement time

(% Delay time




6.2.1. Measurement time

When you use the 'Measurement time' function, you can specify a duration for the Makin’ 3D app to
measure. This feature accounts for GNSS fluctuations by averaging the data for greater accuracy.
Forinstance, if you set the measurement time to 1 minute, the app will calculate the average position

after one minute for a more precise reading.

1) Tap on Measurement time

< Measure time

(% Measurement time

(¥ Delay time

2) Set your desired measurement time.

Measure time

3) Tap on the check mark to save.



6.2.2. Delay time

With the 'Delay time' function, you have the option to postpone the measurement process in the app.
This delay allows the sensors to stabilize before capturing your position, leading to more accurate
results. For instance, setting a 2-minute delay means the app waits for 2 minutes before starting to

measure your position.

1) Tap on Delay time.

< Measure time

(% Measurement time

(¥ Delay time

2) Set the desired delay time.

Delay time

3) Tap on the check mark to save your selection.



6.3. Language

Select the language of your choice. The language is automatically changed and saved.

< Settings

$ Height

<> Side distance

A Alert

0D Measure time

B3 Language

™ Length unit

6.4. Length unit

English

Meters

m x ( Language

English
English UK
Dansk
Deutsch

Norsk

Svenska

Tap to choose the length unit. It is automatically changed and saved.

( Settings

™ Length unit

N
/@ Angle unit

) Sound volume
L External buttons
Change application

Technician functions

Meters

Degrees

Low

>

Centimeters
Feet

Inches
Meters

US survey feet




6.5. Angle unit

Tap to choose the angle unit. The angle unit is automatically changed and saved.

< Settings

™ Length unit Meters Degrees

Angle unit Degrees Percent

o) Sound volume Low Permille
L External buttons > Relative
Change application

Technician functions

6.6. Sound Volume

Tap the sound volume again and again to change the sound level. Choices are given: Low, Medium,
High, Highest.

< Settings E x
™ Length unit Meters
Angle unit Degrees

») Sound volume Low

L External buttons >

Change application

Technician functions




6.7. Area selection

The ‘Area selection’ feature makes selecting objects in areas with many elements (such as points,
lines, or surfaces) easier. When you tap on an area with multiple elements, a list of up to 7 nearby
objects will appear on the screen, which you can choose from by tapping on the object you want to
select. The objects listed are the ones closest to the spot you have most recently tapped. A ring will

briefly appear on the screen to indicate the area you are selecting.

o A

£z Asphalt
#5 Parking lot
232

o P10 (0)
o P11 (0)
/CL

Found 6 elements. Listing the

Station: P

Gl 27.0cm
Height: -
Side:

0.0°

You can enable or disable this feature in the Settings menu. When ‘Area selection’ is disabled, only

one object will be selected when you tap on the screen.
< settings
) Sound volume
L External buttons
Change application

Technician functions

Ignore sensor errors

Area selection




6.8. Calibration backup

You can save a backup of the machine's current calibration file. If the same tablet is used on
different machines, you can also save each machine's calibration as a separate backup, making it
easy to access the correct file.

6.8.1. Snapshots

Every hour, the snapshot function automatically creates a backup file of the current calibration, or
whenever changes are made to the calibration. Please note, however, that if multiple changes are
made within the same hour, the previous file will be overwritten.

You can at any time change back to a previous calibration by selecting a backup file, as described
in section 6.8.3: Select Backup File.

Please note that at the end of the day, the system automatically reviews the day’s backup files and
clears the list so that only the latest calibration remains available

6.8.2. Manual backups

To manually create a backup file, follow the description below.

Step | Action lllustration

1 Open Machine configurations in the < Settings [ X

Settings menu. _
[ External buttons >

Change application

Machine configurations

Technician functions [ ]
Ignore sensor errors @

Area selection o




Select MyMachine.

( Machine config files E x

MyMachine

Select Manual backups.

< Calibration backup E x

Snapshots

Manual backups

Tap the + icon to create a new backup.

< Manual backups m x

Give the backup a name.

Please give the backup a name m

MyMachine_2025-11-27




Save by tapping the check mark.

Please give the backup a name

MyMachine_2025-11-27

4

NB!

The backup file will now be visible in the
Manual backups menu.

< Manual backups

MyMachine_2025-11-27




6.8.3. Select backup file

Please note that the procedure for selecting a backup file is the same for snapshots and manual
backups.

Step | Action lllustration

1 Tap on the calibration file you want to < Snapshots |__7|I x

apply to your system. MyMachine_2025-11-07_12-01

MyMachine_2025-11-11_16-03

MyMachine_2025-11-20_14-09

MyMachine_2025-11-21_11-35

MyMachine_2025-11-24_16-19
MyMachine_2025-11-25_15-26

2 A notification appears on the screen.
Tap on the check mark to confirm.

Attention

Are you sure you want to load:
MyMachine_2025-11-21_11-35? This will overwrite current
calibration.

X
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7. Logging (As-built)
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7.1. Log Point

Log Point is an as-built feature used to document points. You can access it from the Logging

menu or by long-pressing the shortcut on the work screen.

Option A Option B

( Main menu

“ @ i

Project Display Settings Logging

' . A [i
1
D l Statlon:  106.10 m

Tablet Chat Status [ELDE] g 1.7%m
Height: -
Side:

ah 2 O (o]

®  oown 4000 - Mainstipply line 4007 - Bfanchiine

1) Tap ‘Object’. A list of your most recently used objects will appear.

If no objects are shown, click the folder icon, then select a group of objects to find the one
you need.



< Q@ Log point E x ( Objects

Attributes General Coordinates Photo We”

o)) Object Line junction
Attributes ‘

Pipe bend

Drainage

2) Choose the object group that suits your task.
( Object groups
District heating
Electricity
Own objects
Road

Sewage

3) Select the relevant object from the list.
< District heating

A 4000 - Main supply line

District heating - 14xxx - Wastewater

A& 4001 - Branch line

District heating - 14xxx - Wastewater

AA 4004 - Material change

District heating - 14xxx - Wastewater

4) Once the object is selected, tap the Log point icon in the bottom right corner to log a point.



( Q@ Log point m x

Attributes General Coordinates Photo

@ Object

Attributes

‘ 4001 - Branch line

ewat

5) A notification will confirm the point has been logged, including the point number and object

details.

Point logged
P10
Object: 4001 - Branch line

Undo

< Q@ Log point

Attributes General Coordinates Photo

Q) Object 40071 - Branch line

Attributes

You can press ‘undo’ if you regret your last logging. The confirmation pop-up will disappear after

approximately 10 seconds.

Note! The last used object will remain active until it is changed.



7.2. Log Line

Log Line is an as-built functionality used to document how points are connected. Log Line can be
used to document line breaks where there are changes in slope, direction, or if the project requires

it, to document every line junction.
Note! When you log a line with the PerFormans application, you cannot make an accuracy
measurement.

How to log a line:

1) Press and hold the Log line icon at the bottom of the screen for three secondsgi

& %
H:102.11

Station: -
€ls
Height: -
Side:

l—
A% Lo

2) Choose the object that matches your task.



H:102.11 H: 102.11

< Q Create line E X

Attributes General

Q) Object District heating
Electricity

< Object groups

Own objects
Road

Sewage

3) You can start logging a new line in one of two ways:

a. Option 1: By clicking the ‘+" icon located in the bottom right corner.

o #
H: 102.11

( L2 Create line Ei x

Attributes General

Q@) Object Rainwater




b. Option 2: Close the menu and then click on the log line icon on the work screen.

& #

mulatar

H: 102.11

Station: -
CL:
Height: -
Side:

AA
ablet;
® oo ingjunction  Rainwater

You can add line points by tapping the icon (see picture above).

4) To stop this line, press the cancel log line button at the top of the work screen. gi



Station: -
ey
Height: -

7.2.1. Log a new line from an existing line

It is possible to log a new line from an existing line. For example, you can easily log a line junction

for a sewage project by logging a new line from an existing line.

How to:

1) Click on the line on the work screen, or go to Project > References, and activate the line by

clicking on its name.



-

+ 12900 X
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2) Click the gray arrow to expand the line and view the line points in the Reference dialog.
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3) Choose the line point from where you want to start the new line and activate the line point by
clicking on it.

4) Click on the ‘Log line’ icon.
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5) You can now log a new line from an existing line.
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7.3. Swift between logging points and lines

You can log lines and points at the same time. You can, for example, log a line by short-pressing the
log line icon at the bottom of your work screen, and when you want to log a point, you can simply
short-press the log point icon. Even if you move the machine after logging a point, it remains in log

line mode, allowing you to log points at the same time.

Line logging-mode Logging a point while logging a line:

Point logged
Added point to line
Object:

Point logged
P44
Object: Rainwater

Undo Undo

Station: -
ol

Height: -
Side:

Station: -
Tl

Height: -
Side:

— — .
A% Ifah\u o I ‘% Imm o I
0020m  <Lingunet 0020  <Lingfunction>  Ralrigate

7.4. Own objects

You can create your own objects this way:

1) Select Logging in the menu.

2) Select ‘Object’.



( Q@ Log point

Attributes General

Q) Object

3) Tap the folder icon.

< Objects
WE
Line junction
Pipe bend

Drainage

4) In‘Object group’, select ‘Own objects'.

( Object groups
District heating
Electricity

Own objects

Road

1 X

Coordinates




5) Tap'+.

< Own objects

Ditch
Drainage
Line junction
Rainwater
Road

WE

6) Name your object.

New object

7) Tap the check mark to save.

The new object is now stored under ‘Own objects’ and is automatically selected as the default object

for point logging.



7.5. Attributes

If attributes have been created in Makin' Cloud, you can add them to the points, lines, and line points
you want to log. For more details on creating attributes in Makin' Cloud, see section 7.8: Create

objects and attributes on Makin’ Cloud.

Q@ Log point m x

Attributes General Coordinates Photo

Road
Attributes ‘J'

Attributes are characteristics and information that describe a logged point, line, or line point in as-
built documentation. For example, attributes can include details like dimensions, materials used, or

the type of measuring point, etc. The attributes you can use depend on the objects and groups that

have been created for the project in Makin' Cloud.

How to add attributes:

1) Find the appropriate object for your task.

2) Select the attribute you want to add to the point or line.

( Q@ Log point m x

Attributes General Coordinates Photo

Q)) Q_EEject ‘iOOO - Main supply line

Attributes

@ Dimension
@ Material

@ Measuring point




3) Enter or choose the relevant information for the attribute.

< Dimension

9100
110
®160
9200
9250

4) If needed, add more attributes by selecting them and filling in the details.

5) Tap the ‘Log point/Log line’ icon in the bottom right corner.

( Q@ Log point m x

Attributes General Coordinates Photo

Q)) gbjggt 1 A{r‘OOO - Main supply line

Attributes
@ Dimension 2110

@ Material :

@ Measuring point  Bott Q

6) The point or the line is now logged with the added attributes.



7.5.1. Custom attribute
You can create custom attributes for your own objects in the Makin’ 3D app. For example, a custom

attribute can help make the office aware of an unknown cable or notify others about unexpected

items.

1) Tap on ‘Object’ and select ‘Own objects’.
2) Choose the object relevant to your task.

3) Tap the attribute icon.

< Q Log point

Attributes General Coordinates

@) Object

Attributes

4) Enter the details for ‘Title’ and ‘Text'.

5) Tap the '+ button in the bottom right corner.

< Custom Attribute
Title

Broken drain pipe

Text

Found




6) The custom attribute is now added to the object.
7) You can create and add more custom attributes if needed.

8) Tap the Log button in the bottom right corner to log the point or line.

< Q Log point m x

Attributes General Coordinates Photo

Q)) Ob ct Road

Attributes ‘*'

=

> Broken drain pipe




7.6. Log offset
You can log an offset for both point and line point heights:

1) Go to Coordinates > Log offset

< Q Locg point E x < Q@ Log point

Attributes General Coordinates

Q) Object

Attributes General Coordinates

Northing
Eastern
Height

4 Log offset

2) Enter the measurement for the offset.

Log offset




3) Click on the check mark.

Log offset

4) The result will show two numbers for the height, like this: (0.00) -1.35. The number in the
parenthesis is the logged point's height, and the number after the parenthesis is the

calculated height after applying the offset.

5) Click on the log point icon in the bottom right corner.



< ¥/ Q Log point
Attributes General Coordinates

Northing
Eastern
Height

4 Log offset

6) You have logged an offset for the point or line point:

Point logged
P23
Pointcode: Well

Log offset: -1.35 m

Undo

< 1 @ Log point

Attributes General Coordinates
Northing 112417
Eastern
Height

4 Log offset




7.6.1. Edit a log offset
To edit a log offset for a point or a line point:

1) Go to Project > References

2) Click on the point or line point name.
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3) Click on the pen tool to edit.
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4) Go to ‘Coordinates’.

5) Click 'Log offset’.

< Q Edit log point

Attributes General

Northing
Eastern
Height

4 Log offset
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6) Set the offset and click on the check mark.

7) Click on the check mark in the bottom right corner.

< Q Edit log point

Attributes General Coordinates
Northing
Eastern
Height

4 Log offset

8) The offset is now edited.

7.7. Photo

You can add photos to the as-built documentation by taking photos of objects you want to call
attention to and document.

1) Log a point or line point.
2) Edit the logged point or line point:
a) Option A: Click on ‘Edit’ in the notification

b) Option B: Long-press the point on the work screen. Click on the pen tool.



c) Option C: Click on the point’s name in the reference dialog. Then, click on the pen
tool.

3) Click on the tab ‘Photo’.

ﬂ ( @ Edit log point E x
7

N: 11241 32.64 Attributes General  Coordinates Photo
5 11.07

H-100.15 Q) Object Rainwater

- < Q Edit log point |1/, x

N: 1924132.64 Attributes General Coordinates Photo
E:611011.07

H: 100.15 n
D
11

Station: -
CLs
Helght:
Side:

o 1 @ )
Sewage pipel ™ Rainwater’
P v

5) Take the photo by clicking on the camera icon.



6) Click on the check mark.

7) Click on the checkmark in the bottom right corner to confirm the editing.



o[ '@ .qil ( Q Edit log linepoint
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8) Your photo has now been saved as as-built data for the logged point.

9) The photos used for documentation can be downloaded as as-built data from Makin’
Cloud.

7.8. Create objects and attributes on Makin’ Cloud

You can create objects and attributes for a project on Makin’ Cloud. Objects and attributes can be
created in a specific project or set as default project files. Please note that if you create objects and
attributes as default project files, they will be available in all new projects in the organization on
Makin’ Cloud.



For a specific project:
Makin’ Cloud > Choose organization > Projects > Select project > Attributes

mRAICHT ations / Makin

Dashboard Projects Systems sers [ ransfe Suborganizations

ENG - road project demo

Add folde! Download folder  Show deleted files |
files

Name Size Last modified Actions
1 Road Models 5 months & & W
6 Yard 5 months [ |
Codes 5 months ) g [ |
Driveway 5 months & 2 W
Project codes 5 months PR A |
Vegetation 5 months AV |
2 Water 0B 5 months Y |
CL-road.xml 13.2 KiB 5 months i s 0
Diteh.xml 37.0 KiB 5 months i ramn |
Fixpoints.txt.xml 2.5KiB 5 months i " |
Lines-Driveway4.xml 39.7 KiB 5 months i s
Lines-driveway-2D.dxf 391.0KiB 5 months i r 4 |

Default project files:

Makin’ Cloud > Choose organization > Settings > Default project files > Attributes

ITMECIIT  Organizations | Makin

Dashboard

Settings

Projects Systems Users censes Suborganizations Settings

Default project files
T file: automatically vied fc vly created projects. N at only .ixt og Add folder

files
Name Size Last modified Actions
Objects 7 months A |
Project objects 6 months A A |
txt 22 days A N |

Drag files or click to select files (zip-files are automatically extracted)



7.8.1. How to create objects
1) Click on ‘Edit’ to begin creating a new object.

ITIAICITT Crganizations / Makin

Dashboard Projects Systems Users Licenses Transfer Suborganizations Settings

ENG - road project demo

® Project

Edit #

2) First you need to add and name the group, e.g. Sewage.

ITYICTIT  Organizations / Makin

Dashboard Projects Systems Users Licenses Transfer Suborganizations Settings

ENG - road project demo

® Project

Save B Filter ¥

+ New group

0

3) Add subgroups for more details. For example, if the group is ‘Sewage’, you can add a

subgroup called ‘Wastewater’.



ENG - road project demo

i Project

Save @ Filter ¥

4) Add and name the object.

ITIAICITT? Organizations | Makin

Dashboard Projects Systems Users Licenses Transfer

ENG - road project demo

® Project

Save B Filter ¥

~ Sewage

»  Attributes

I + new object l

+ new subgroup
+ new subgroup

+ new subgroup

organizations

Settings



5) You can add an ID to the object and choose the relevant applications and geotypes (point,

line, line point) where the object can be used. Click on the icons to select or deselect. Icons

will grey out when deselected.

id 4000
name Main supply line
wee (4
geotype @

6) Add more objects if needed.

Makin

maAicir

Organizations

Dashboard Projects Systems Users Licenses Transfer Suborganizations Settings

ENG - road project demo

® Project

Save @ Filter ¥

~ Sewage
» Attributes
»
v 14xxx
»
»
~ Wastewater
»
~ Objects
» 4000 - Main supply line
» 4001 - Branch line

» 4004 - Material change

I+ new object I -

7) Click ‘Save’ to save your changes.



MR

Dashboard  Projects

ENG - road project demo

o

Attributes.

name Sewage

' wps  (Y[0)[T] (=]
+ new subgrour geotype (o]

7.8.2. How to create attributes
1) Click on ‘Edit’.
2) Add and name the attribute.

IMIAICIIT  Organizations

Dashboard Projects

ENG - road project demo

®P

Save @ Filter ¥

3) You can choose which applications and geotypes (point, line, line point) you want the
attributes.



IMAICHT Organizations

ard  Projects

ENG - road project demo

® Project Files  Attributes  As-buil Settings

Save @ Filter ¥ Help ?
——————————————— —
~ Sewage I . I
- Attributes I name Dimension I
| = OD0E: !
l | wom [0 |
+ new attribute
‘ I type number v I
» | I
> 14xxx I I

—— e —
+ new subgroup

» District heating

4) You can also add further information in the form of number, text, or list under ‘Type’. The

chosen type decides how the user of the application can add details to the attribute:

a. Number: The user can enter a number on the tablet.
b. Text: The user can write a text to the attribute.

c. List: The user can choose between the options created on Makin’ Cloud.

name Dimension

apps @ n ) | R
geotype [EI

type

Jiist



i. If you choose ‘List’, you can write the options for the list. Click on ‘Option’ to

add an option to the list:

name Dimension

apps E] | |4%
geotype @

type list v
option 1 2100
option 2 ‘
Options 4+

ii. Name the option. Click on ‘Option’ to add more options.

name Dimension
apps co
geotype
type list ~
option 1 @100
option 2 2110
option 3 2160
Options 4

5) Add and name more attributes if relevant.



IMIAICII?  Organizations / Makin

Dashboard Projects Systems Users Licenses Transfer Suborganizations Settings

ENG - road project demo

® Project

Save @ Filter ¥

v Sewage
~ Attributes
Dimension

Material

I+ new attribute l

»
> 14xxx
+ new subgroup
» District heating

+ new group

6) Click on ‘Save’ to save your work.

When you have saved the work, the objects and attributes will automatically be synchronized from

Makin’ Cloud to the project on the tablet.

The attributes and objects you have created can be selected by long-holding the log button or

tapping ‘Logging’ in the main menu in the Makin’ 3D app.

7.8.3. Filter for overview

The 'Filter' function allows you to search and see which attributes and objects are added for

specific applications or geotypes (point, line, line point).

1) Click on ‘Filter’.



ITIAICIIT Organizations / Makin

Dashboard Projects Systems Users Licenses Transfer Suborganizations Settings

ENG - road project demo

™ Project
Edit # Filter ¥ «

» Sewage

» District heating

2) Select the applications and/or geotypes (point, line, line point) you want to filter.

ITIICII?  Organizations /| Makin

Dashboard Projects Systems Users Licenses

ENG - road project demo

® Project

Edit # Filt%Y
Applications
» S Q Excavator 3d
) Performans
T Survey

Ef Tool Guidance

«& Wheel Loader

1]

G

otypes
O Point
_{ Line

@/ Linepoint



3) If an attribute or object is not added for a specific application or geotype (point, line, line

point), a red eye icon will show that it is not visible for that application or geotype.

ITIAICTIIT Organizations / Makin

Dashboard Projects Systems Users Licenses Transfer

Suborganizations

ENG - road project demo

@ Project

Edit # Filter ¥(1)

~ Sewage
~ Attributes
@ Dimension
@ Material

Measuring point

»

> 1dxxx
»
»

» = Wastewater

» District heating



7.9. Object information and attributes

When a point is logged, several different information is logged together with the object and

coordinates. Below, you can see a list of information with an explanation of the different values.

Point name: A unique name used to identify
individual points

N: The measured points northern coordinate.
This value is measured on the tool point

E: The measured points’ eastern coordinate.
This value is measured on the tool point

H: The measured points elevation. This value is
measured on the tool point

VRMS: Shows the vertical accuracy of the
GNSS when the point was logged. Accuracy is
defined on the GNSS antenna, not the tool
point

HRMS: Shows the horizontal accuracy of the
GNSS when the point was logged. Accuracy is
defined on the GNSS antenna, not the tool
point

Mount point: Shows which mount point was
chosen for the connected NTRIP server

Project offset: If an application has a project
offset entered to adjust tool point elevation to
match the elevation of a known point on the
construction site.

ExtSurf: Showing if the point measured is done
on an extended surface value can be 0(no) or
1(Yes)

ToolHeight: Shows the height offset applied to
the measured tool point, e.g. Pole height for
Makin’ Survey, or Tablet height for Makin’
PerFormans

Time: The time where the point was logged
logged in a YYYY-mm-dd HH:MM:ss format
Example: 2022-02-15 09:43:34

SystemName: Shows the name of the system
that logged the point. This system name
matches the system name on the Cloud

PDOP: Dilution Of Precision, indicates how
errors in measurement will affect the absolute
position calculation. Dop can be calculated in
different variants. (HDOP, VDOP, PDOP, TDOP,
GDOP)

The DOP value logged in the as-built data is the
PDOP value. (Position dilution of precision)
This can be considered as the 3D DOP. The
value is relative and not related to a specific
measurement unit.

Sats: Showing how many satellites were visible
when the point was logged. The value is the
sum of satellites, and not divided into specific
satellite constellations (GPS, Glonass, Beidovu,
Galileo)

LogOffset: Delta height. Shows if the operator
has added an offset to the logged point. Often
used if it is impossible to log the exact position
due to limited space. E.g., logging the inlet in a
manhole. Then the operator can log a point on
the top of the manhole, measure the distance
from the measured point to the inlet, and enter
this as a delta height.measured. Value shows
accuracy in meters

SiderefFile: Side reference file. Shows the
name of the file used as active side reference
when point was logged




App: Shows which system has logged this
specific point.

SiderefName: Side reference name. Shows the
name of the specific reference inside the
reference file, used as an active side reference
when a point was logged.

HeightOffset: If the operator has entered an
offset, the value is documented in this field.
This offset will have a direct effect on the Href
value.

Sidedist: Shows the horizontal distance from
the tool point to the side reference when the
point was logged.

POI: This is set if the operator has marked a
point as a Point Of Interest. The value can be 0
(no) or 1 (yes).

HeightrefFile: Height reference file. Shows the
name of the file used as the active height
reference when the point was logged.

ToolPoint: Shows which tool point was used to
log the point. Only relevant for Excavators that
can switch and log with Left, Center and Right
tool point on the bucket.

HeightrefName: Height reference name.
Shows the name of the specific reference
inside the reference file, used as the active
height reference when the point was logged.

Height: Shows the vertical distance from the
tool point to the height reference when the
point was logged.

Comment: If the operator has written a
comment for the point, it will be shown here.

7.10. Sort as-built data

Inside the reference menu, it is possible to enable sorting of the project’s as-built data. Press the AZ

button to open the sorting dialog.

N: 1314172.41
E:75748.08
H:234.81 =
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mm Road Project
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v Road model
vV Surface
> Surfaces
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In this dialog, you can choose which criteria you want to sort by. Press the button to activate or
deactivate the criteria. You can also change the order you want to sort by. This is done by pressing

and holding on a criterion and then moving it up or down the list.

Sort as-built
lA
Z
:: Point code
i+ POI

:: Application

:: Creator
;i Geometry type
i Date




8. GNSS
< Main menu m x
“w @ i @O ~

Project Display Settings Logging GNSS

0O " A

Tablet Chat

8.1. Correction source

In the ‘'GNSS’ menu, you can choose whether you want to run with the GPS receiver towards NTRIP
(CPOS, Smartnet, TopNet) or UHF (radio) towards a local base station. If you choose UHF, you must

select the frequency and ID that allow Makin’ 3D to communicate with the base you want.

How to choose and create a correction source:

1) Go to GNSS > Correction source



H: 100.84

€ oNss [ X
GNSS device Reach Emlid (Blue
Heading method GNSS trace
Bluetooth 192.168.99.240

Correction source

2) Inthe correction source dialog, you can activate and deactivate NTRIP and UHF profiles.

You can also create or edit a correction profile.

< Correction source + Ve E x

3 dk.nrtk.eu- 10300 ®

“1" UHF_1

Radio not supported

3) To create a correction profile, tap on the ‘+' symbol. Edit a correction profile by tapping on

the pen tool.



< Correction source + /’ E x

[ dknrtk.eu - 10300 ®

“1" UHF_1

Radio not supported

4) When tapping on the ‘+’ symbol you can choose between creating a NTRIP or UHF profile.

See the paragraphs below for more information about UHF and NTRIP.

8.1.1. Radio (UHF)

Under ‘Correction source’ you see the current type of correction source being used.

e Choose ‘UHF’ if you use a radio to connect to the correction signal.

How to create a new UHF profile:

1) You can create a new UHF profile by tapping on ‘+" symbol and then the UHF icon.



2) To set up the UHF profile, the following details must be entered:

< UHF(1)
((I” NET

I(LI Bandwidth

"\, Frequency

ﬁ Protocol

& reC

23 Scrambling
“A) Base ID

e Name: Name the UHF correction profile.
e Bandwidth: Select either 25000Hz or 12500Hz.
e Frequency: Tap ‘Frequency’ to set the frequency of the base station.

e Protocol: Choose the protocol you want to use.



< Edit protocol

Satel

PacCrest 4-FSK
PacCrest GMSK
TrimTalk450S P
TrimTalk450S T
PacCrest FST

e FEC: Tap the button to activate or deactivate the FEC.

e Scambling: Tap the button to activate or deactivate the scrambling.

e Base ID: Tap ‘Base ID’ and choose ‘Auto’ to automatically jump between base stations with
the same frequency or choose an ID of a specific base station to lock on to it by tapping on

‘Custom’.

Please note, that if you use the ‘Auto’ option, you might experience corrections from two

bases, which is not optimal.

1) Choose between ‘Auto’ or ‘Custom’ to set the Base ID.

< Editbase D

Auto

Custom

2) Tap on ‘Custom’ to choose an ID of a specific base station.



( Edit base ID

Auto

Custom

3) Set the ID of the specific base station you want to lock on to. Tap on the check mark to

save.

( Custom Base ID @ s E x
28 +

When you have created a UHF correction profile, you can activate the correction source you want to

use. The current correction source will automatically deactivate.

< Correction source + /’ E x

[ dk.nrtk.eu 10300
) NTRIP

“1" UHF_1

“" UHF_2




8.1.2. NTRIP

Makin can use corrections from several NTRIP providers. Depending on the installed GNSS receiver,
the information must be entered by the Makin’ supporter or installer in the Makin’ application's GNSS
menu. Makin needs some NTRIP server details to be able to connect to the server and receive useful
corrections. These details will be delivered from the selected NTRIP provider when subscribing to

an account.

1) You can create a new NTRIP profile by tapping on ‘+' symbol and then the NTRIP icon.

2) To connect to the NTRIP network and receive corrections, the following details must be
entered:

o
P-4 Username

P Password

‘N Mountpoint

e NTRIP name: Name the NTRIP correction profile.



e NTRIP server: The web address where the server can be accessed.
e NTRIP port: This is usually a 4-digit number from where Makin must receive the corrections.

e NTRIP username: Every Ntrip account on the server has a unique username that Makin needs

to log in to the server.

e NTRIP password: Every Ntrip account on the server has a unique password that Makin needs

to log in to the server.

e NTRIP mountpoint: This mountpoint defines which corrections and from which GNSS

satellites Makin can calculate an accurate position.

Please note that the mountpoint is custom. You need to fill in the details for the mountpoint.

1) Tap on ‘Mountpoint’.

o

- Username
P Password
@ Mountpoint

2) Tap on ‘Custom’.

< Edit mountpoint

Custom




3) Enter the mountpoint name. Tap on the check mark to save.

Custom mountpoint

When you have created a NTRIP correction profile, you can activate the correction source you want

to use. The current correction source will automatically deactivate.

< Correction source + /’ E x

[ dknrtk.eu- 10300
G NTRIP
“1" UHF_1

“1" UHF




8.2. Heading method

Makin can change the heading method to suit the needs of the user. The heading method defines

how the background map and references are rotated on the tablet.

Centerline:
If the centerline heading method is chosen, the map and references will by default be rotated so the

project centerline is pointing up/down on the screen.

North:
If the north heading method is chosen, the map and references will by default be rotated so that the

north is pointing upwards on the screen.

Trace:
When the trace heading is selected, the map and references will dynamically rotate upwards on the

screen in the direction of travel. The trace heading angle is calculated between the previous
positions and the current position. When the direction of travel is changed, the map and references

on the screen will automatically rotate to the new direction of travel.



8.3. Bluetooth

Some of the Makin’ PerFormans and Makin' Survey applications are using Bluetooth to
communicate with the GNSS receiver. To set up the Bluetooth connection, you must go to Main Menu

> GNSS > GNSS device and select ‘Reach Emlid’' for the PerFormans application or ‘Hemisphere

S631’ for the Survey application.

*‘)) Bluetooth signal is full
*‘) Bluetooth signal is half

*‘ Bluetooth signal is low
*X No Bluetooth signal

8.3.1 Makin’' PerFormans
When you connect the unit for the first time, you have to pair the device with the tablet. Make sure
the Makin’ PerFormans device is turned on, you are outside with a clear view of the sky, and all LEDs

are turned on with a solid light. Now the device is ready to connect to the tablet.



8.4. Connecting and pairing Bluetooth

Go into Main menu > GNSS > Bluetooth and press the Bluetooth icon at the top .
Now you will start a search process, searching for the unit among any nearby devices.

When the unit is located, the device name will show up. In the below example the unit name is “Reach-

mesa3”

Nearby devices

Reach-mesa3

Press the device name to connect to the device. In the Bluetooth menu, you will see the Bluetooth

address. Press Ok to establish a connection.

Pay attention to the GNSS icon at the top . With this icon connection to the GNSS device means
that it is still waiting to be established; this might take 2-3 minutes when all LEDs on the GNSS device

are turned on with a solid light. When a connection has been established, the GNSS indicator

changes to this icon . The connection has been established. When indoors, you will see a
warning on the tablet saying “No position from main antenna”. Once you step outside, the message
will change to "No RTK Correction” on the work screen, while the receiver is tracking available

satellites. The message will disappear once the device establishes an RTK fix position.



9. Tablet

< Main menu

A @ i

Project Display Settings Logging

0O "W A

Tablet Chat Status Manual

There is a shortcut to this menu from the quick keys in the bottom left corner of the work screen

l—
Tablet

1:200 m

In this menu, you can enter and save different offsets for the tablet height. When a height is entered,
this height is added to the measured GNSS height automatically. This is helpful if you use the tablet
in various setups, such as mounted on a pole, attached to a UTV, or inside a vehicle. If you are

working with several different tablet heights, you can store each for easy access and use later.

Create a new tablet:

Tap the '+ button to create a new tablet.

Edit an existing tablet:

Select an existing tablet and tap the pen tool to edit the tablet's name, measurements, and tool

types.



You can choose from various types and colors to improve tool visibility on the screen. See the

sections below.

9.1. Name

In the tablet calibration, tap ‘Name' to edit the tablet's name. Type the name and tap the check mark

to save.



9.2. Height

Tap ‘Height’ to enter the height of the tablet’s position. The height is measured from the ground to

the position of the tablet. Tap the question mark icon for a visual guide. Tap the check mark to save.

Please note: Even with the correct height offset entered, the PerFormans application has an

inaccuracy margin of about 10 centimeters when measuring height.

9.3. Tool model

You can choose a different tool model to improve the tablet's visibility in Makin’ 3D.

1) Select an existing tablet or create a new one.

2) Tap the pen tool to edit an existing tablet.

3) Tap ‘Tool model’.



( Tablet (1) -[ﬁ E X

Name Tablet (1)
Height 1.200 m
Tool model Typel

Tool color

4) Choose the tool model type that best suits your needs.

£ Tool model
O Typel
@ Type2
©) Type3
© Typed

/O\ Type5




9.4. Tool color

You can choose a different color to improve the tablet's visibility on the screen.

1) Select an existing tablet or create a new one.

2) Tap the pen tool to edit an existing tablet.

3) Tap ‘Tool color'.

( Tablet (1) '[i]' m x
Name Tablet (1)
Height 1.200 m
Tool model Typel

Tool color

4) Select a color that enhances the tool’s visibility on the screen.



< Select color

[ ]
_ [
HEE
] ]




10. Chat

The chat feature helps you communicate with your colleagues about the project you are working on.

<Mainmenu mx
“w @ i O ¥

Project Display Settings Logging GNSS

O "™ A &

Tablet Chat Status Manual

e You will see all office personnel and coworkers from your company or project. This depends

on the structure created by your management.

e Tap a contact from the list to begin messaging.

Select conversation Alexander

Lars

= I

Morten

KlausSpandet

Glen

Hi Alex please come to the

e Write a message and tap ‘Send’.



11. Status

This is where you will find various details about the system information.

(Mainmenu Ex
“w @ i 9O

Project Display Settings Logging GNSS

0O " A

Chat Status Manual

e Tap ‘GNSS' to see the connection status and your location.

e Tap ‘Sensors’ to see detailed sensor information.

e ‘Version'is the current Makin’ 3D software version of the Android app running on your tablet.

e ‘IB-1 version' is the firmware version of the interface box connecting all the sensors to the

system.

é Main menu | Status

GNSS

Sensors

Version

IB-1 version




e System info: You can find all relevant information about your system by selecting ‘System
info’. Information such as System name, System number, System owner, and the associated

licenses are shown here. When changes are made to the system, they will be shown under

System info.



12. Troubleshooting

Error message Possible cause Possible Solution

If you cannot solve the problem using the advice found in the above table, contact your reseller.



13. Appendix
13.1. Software updates

When updating the Makin’ 3D app to a new version, you might receive a notification from Google

Play Protect. To proceed with the installation, allow Google Play Protect to scan the app. This

ensures the new software version is safe to install.

1) Tap on ‘Scan app'’.

© Google Play Protect

App scan recommended

S Vekinmd

2) Tap ‘Install'.



© Google Play Protect

This app looks safe

% Makin 3D

Station: 253.32m
1.61m

3) The Makin’ 3D app is now updating to a new software version. Please wait while the update

is installed.



13.2. GNSS limitations

Always take into consideration where your machine is located. Especially when x

the construction site is within city limits with tall buildings or other obstacles. Sats: 11
DOP: 1.6

Also, if working near forest and mountain areas, interference could block the signal from one or

more satellites and cause poor precision. Reflections could also occur.

Makin’ 3D will inform you if there are not enough visible satellites or if your CQ/DOP is too high.

1. Direct signal blocked 3. Multipath errors

2. Direct signals perfectly received



13.3. Frequency

In situations where you have to specify the frequency according to a channel, refer to the table below
for guidance. Channel 0 is the center frequency, and channels are distributed with a 25 kHz spacing

(in this example).

Channel Frequency (MHz)
0 446.6000
-1 446.5750
-4 446.5000
-5 446.4750




13.4. Compliance information

This product is intended to be mounted on earth-moving machinery exclusively for professional use,
i.e. the product falls into the category: non-road vehicles exclusively for professional use. Makin
hereby declares that the system and its components fulfill the requirements of the following EU

directives applicable to this product category:

e 93/68/EEC - CE conformity marking
e 2014/53/EU - Radio Equipment Directive
e 2014/30/EU - EMC directive

o DS/EN/ISO 13766-1:2018 - Earth-moving and building construction machinery —
Electromagnetic compatibility (EMC) of machines with internal electrical power
supply — Part 1: General EMC requirements under typical electromagnetic

environmental conditions

o DS/EN/ISO 13766-2:2018 - Earth-moving and building construction machinery —
Electromagnetic compatibility (EMC) of machines with internal electrical power

supply — Part 2: Additional EMC requirements for functional safety

The respective product category falls outside the scope of these directives:

e 2011/65/EU - RoHS
e 2012/19/EU - WEEE



13.5. Tablet connections

13.5.1. Tablet Panasonic FZ-A3 connections

The Panasonic FZ-A3 has connectors located in four places: on the top, on the side, inside the battery

compartment, and at the bottom.

1. Mini-jack audio output 4. 16 V DC input power for external
charger
2. Micro SIM card for broadband internet 5. USB-A

on both tablet and GNSS receiver

3. Docking station connector for data and 6. USB-C
power transmission



13.5.2. Tablet Panasonic FZ-A2 connections

The Panasonic FZ-A2 has connectors on the top, on the side, inside the battery compartment, and

at the bottom.

1. 16 V DC input power for external 5. HDMI output to external screen
charger
2. Docking station connector for data and 6. SuperSpeed USB-A 3.0

power transmission

3. Micro SIM card for broadband internet 7. Mini-jack audio output
on both tablet and GNSS receiver

4. USB-C 8. Micro SD for extended storage



13.5.3. Tablet Juniper Mesa3 connections

The tablet Juniper Mesa3 has connectors on the side and at the bottom.

1. 12V DC input power for external 3. SuperSpeed USB-A 3.0
charger
2. Docking station connector for data and 4. USB-C

power transmission



13.6. Tablet set-up

13.6.1. Tablet buttons and light indicators (Panasonic FZ-A2)

Panasonic
Pl

meucin 3o

1. On/Off button

2. Power indicator

e No light: System is off

e Green light: System is on

e Blinking green light: Tablet in sleep
mode

3. Charging indicator

e No light: External power source
not connected

e Red light: Battery power is
critically low. External power
source is not connected.

e Orange light: Tablet is currently
charging

e Green light: Tablet fully charged

TOUGHPAD

4. Auto-rotate screen. The button can be
programmed (more info below).

5. Volume up

6. Volume down

7. Not in use. The button can be
programmed (See section 13.6.2. below).

8. Not in use. The button can be
programmed (See section 13.6.2. below).

9. Basic tablet functionality via the
‘Dashboard’ app. The button can be
programmed (See section 713.6.2. below).



13.6.2. Tablet buttons and light indicators (Mesa3)

1. On/Off button

5. User-programmable function key (See
section 13.8.4. below).

2. User-programmable function key (See
section 13.8.4. below).

6. User-programmable function key (See
section 13.8.4. below).

3. User-programmable function key (See
section 13.8.4. below).

7. User-programmable function key (See
section 13.8.4. below).

4. User-programmable function keys (See
section 13.8.4. below).

8. LED light indicators




13.6.2. Programming the physical tablet buttons (Panasonic FZ)

The Panasonic tablet has three user-programmable function keys, A7, A2, and A3. You can assign
Makin’ 3D functions to these keys.

Step | Action lllustration
1 Open the app UserButtonManager.
2 Select the physical button to which you
want to assign the Makin’ 3D function (A7,
A2 or A3).
: Program 1
. Program 2
: Program3
A1+A2 : Do nothing
3 When clicked, a pop-up window will open. Errm
Se|eCt the deS”'ed fUﬂCtIOI’] - |t Wl” be Please select a function
labelled Program 1, Program 2 or Program 3 Security Mode
depending on the button you select in the Launch an apalication
Makln’ 3D app' Take screenshot
Back
Home
Menu
Program 1
Program 2
Program 3
4 Go to the Settings menu in the Makin’ 3D
app g < Settings |__/-1, x
) Sound volume Low
5 Open the External Buttons menu.

L External buttons >

Change application

Technician functions ®

Ignore sensor errors o

Area selection )




Click the button you want to program
(Program 1, Program 2 or Program 3).

Note:

If the button does not appear on the list,
press the physical button, this will add the
option to the list.

< External buttons
Keyboard F2

N action

Keyboard F3

Nao action

Keyboard F4
Program 1

Lag point

Program 2

Nao action

Program 3
No action

Select the function you want to assign to
the button.

< Program 1 E x

No action

Change toolpoint

Zero plane

Check that the function has been assigned
to the button. The function appears beneath
the button name. If a button has not been
programmed, it will show the description No
action.

e

Program 2

No action

Program 3

No action




13.6.4. Programming the physical tablet buttons (Mesa3)

The Mesa3 tablet has multiple user-programmable function keys. You can assign Makin’ 3D
functions to up to four of these keys.

the button.

Step | Action lllustration
1 Go to the Settings menu in the Makin’ 3D < Settings 7 X
app.
Length unit Meters
2 Open the External Buttons menu. Angle unit Percent
Sound volume Highest
L External buttons
Technician functions
Area selection
3 ,(__);c;_( ;r:: ,Ej)t_ton you want to program (F7, < External buttons
5Syboard F1
Kﬁyboard F2
ﬁg}(baard F3
}éﬁ}/board F4
4 Select the function you want to assign to

€ Keyboard F1

No action

Change toolpoint

Zero plane




Check that the function has been assigned
to the button. The function will be displayed
beneath the button name. If a button has
not been programmed, it will display the
description No action.

£ External buttons

hoard F1

Keyboard F2

Mo action

Go to the tablet’s Setting menu.

Select the menu Keypad.

09.00 VUTEM 2L WB3 %

Q_  Spg efter indstillinger

Netveerk og internet
WI-Fi, mobilnetvaerk, dataforbrug

B

04 hotspot

Keypad
Programmable keys, keypad brighlness

O e

Touch Conlro

Go Forbundne enheder

Bluetooth, Android Auto, NFC

Apps og notifikationer
Senesle apps, standardapps

Select the physical button to which you
want to assign the Makin’ 3D function.

09.01 TUEM 21 MBI%

/'\

Keypad Q

Keypad brightness level

Back Key
F1

Home Key
Home

App Select Key
FZ

Left Key
None

When clicked, a pop-up window will open.
Select the desired function — it will be
labelled F1, F2, F3, or F4, depending on the
button you selected in the Makin’ 3D app.

FUTESL 21 MBI %

@
]
[+]
=
=~
2

None

Back

Home

App Select

Volume Up

Volume Down

Brightness Up

OO OO0 00 0 0

Brightness Down
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Open the External Buttons menu and press
the physical button you selected in step 8.
The button you chose in step 3 will light up
green when the physical button is pressed,
confirming that the programming was
successful.

€ External buttons

Kgyboard F1

Keyboard F2
Keyboard F3

No action

ﬁgryboard F4




13.7. Demo mode

You can use your Makin’ 3D system on Windows in demo mode to gain confidence in the user

interface.

Please find below the shortcuts for the functions.

Keyboard Action
— Rotate camera left
— Rotate camera right
| Tilt camera down
1 Tilt camera up
Space Start/stop automatic driving
+ Raise machine model

- Lower machine model

Change view (sampling through options)

n Drive forward (in direction of model orientation)
Shiftn/N Drive backwards (in direction of model orientation)
s Drive forward along pre-determined line (centreline)
Shifts/ S Drive backwards along pre-determined line (centreline)
i Jump around close to the project
Shiftj /J Jumps to the roundabout in Odense S
u Jump to current side reference

p Opens the Plan menu




o Opens the offset menu
g Opens the jog window
w Activate/deactivate wireframe mode
r Refresh / Finds the model
R Reload / reset model orientation (undoes number key modifications)
1 Tilt model to the left (Roll)
Alt 1 Tilt model to the right (Roll)
2 Tilt model forward (Pitch)
Alt 2 Tilt model backwards (Pitch)




13.8. Xbox controller

You can use an Xbox controller to control the machine model in the Makin’ 3D app on your tablet. It
is an easy way to gain confidence in the user interface. This feature is only available when you

connect the Xbox controller to a Panasonic FZ-A3 tablet.
How to connect the Xbox controller to your tablet:

1. Go to Settings on your tablet.

2. Click on Connected devices.

3. Press the connect button on the Xbox controller. The button is located on on top of the

controller (Number 4 on the image below).
4. Click on Pair new device.

5. Click on the available Xbox Wireless Controller on the tablet screen. Wait for the devices to

pair.
6. Your Xbox controller is now connected to the tablet and ready for use.
Please note:

The available functions depend on the machine model activated on the tablet. Use the table below

to see the button functions for this model.



Button direction

Drive mode

1 Forward

Drive forward

1 Backwards

Drive backwards

1 left Turn machine left
1 right Turn machine right
2 Decrease turbo (stepwise)
3 -
4 Connect controller
5 Power on/off




Increase turbo (stepwise)

10

11

12 forward

12 backwards

12 left

12 right

A

Move machine down 1 meter

Move machine up 1 meter
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